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About this document

A newer version of this document may be available on the web here
Scope and purpose

The Smart I/0 Configurator is part of a collection of tools included with the ModusToolbox™ software. It
provides a GUI to configure the Smart 1/0.

Intended audience
This document helps application developers understand how to use the Smart /0 Configurator as part of

creating a ModusToolbox™ application.

Document conventions

Convention Explanation

Bold Emphasizes heading levels, column headings, menus and sub-menus

Italics Denotes file names and paths.

Monospace Denotes APlIs, functions, interrupt handlers, events, data types, error handlers, file/folder
names, directories, command line inputs, code snippets

File > New Indicates that a cascading sub-menu opens when you select a menu item

Abbreviations and definitions

The following define the abbreviations and terms used in this document:
+  HSIOM - high-speed I/0 matrix

«  PDL - peripheral driver library

+ UDB - universal digital block

Reference documents

Refer to the following documents for more information as needed:
«  Device Configurator user guide
+  ModusToolbox™ tools package user guide
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1 Overview

1 Overview

The Smart I/0 block adds programmable logic to an I/O port. It is positioned in the signal path between the
high-speed 1/0 matrix (HSIOM) and the I/O port. The HSIOM multiplexes the output signals from fixed-function
peripherals and the CPU to a specific port pin and vice-versa. The Smart I/0 block is placed on this signal path,
acting as a bridge that can process signals between port pins and the HSIOM, as shown in the following
diagram. For more information about the Smart 1/0 block, refer to the device Technical Reference Manual.

SMART I/O

Data Unit

HSIOM ¢

1/0 port

Routes signals
from chip to 1/0
pins

Chip connections Routing 1/0 connections Pins in a
SMART /O port|

LUT

There are several areas in the GUI to configure signals: Chip, /0, Data Unit, and LUT. Inputs to the chip from the
I/O port can be logically operated upon before being routed to the peripheral blocks and connectivity of the
chip. Likewise, outputs from the peripheral blocks and internal connectivity of the chip can be logically
operated upon before being routed to the 1/0 port.

The programmable logic fabric of the Smart 1/0 can be purely combinatorial or registered with a choice of clock
selection. The functionality is completely user-defined, and each path can be selectively bypassed if certain
routes are not required by the fabric.

Each Smart /O is associated with a particular I/O port and consumes the port entirely. If the Smart /0 is not
enabled, then the Smart I/0 functionality for that port is bypassed.

Note: Bypassed means each chip terminal is routed directly to the corresponding I/0 terminal.
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2 Launch the Smart 1/0 Configurator

2 Launch the Smart 1/0O Configurator

There are numerous ways to launch the Smart I/O Configurator, and those ways depend on how you use the
various tools in ModusToolbox™ software.

2.1 make command

As described in the tools package user guide build system chapter, you can run numerous make commands in
the application directory, such as launching the Smart I/0 Configurator. After you have created a
ModusToolbox™ application, navigate to the application directory and type the following command in the
appropriate bash terminal window:

make smartio-configurator

This command opens the Smart I/O Configurator GUI for the specific application in which you are working.

2.2 VS Code and Eclipse

VS Code and Eclipse have tools to launch the Smart I/0 Configurator from within an open application. Refer to
the applicable user guide for more details:

+ VS Code for ModusToolbox™ user guide
+  Eclipse IDE for ModusToolbox™ user guide

2.3 From the Device Configurator

To launch the Smart /O Configurator GUI from the Device Configurator:
1. Open the Device Configurator. See the Device Configurator user guide for details.

2. On the Pins tab, expand Port 8 and/or Port 9, and enable the Smart I/O resource.
3. Click File > Save to save the configuration.
4, On the Parameters tab, click the Launch Smart 1/O Configurator button.
File Edit Settings View Help
CVYSC624ABZI-S2D44  LBEESIBILV/CYWA3DI2COWKWBG Smart |/0 & - Parameters 8 x
Peripherals ~ Pins  Analog-Routing  System  Peripheral-Clocks ~ DMA Enter filter text S8 T BB
|E".e-" lter text ZITER| A4 B0 &3 Name Value
Resource MName(s) Personal ™ v Overview
v Port8 (7) Configuration Help Open SmartlO Documentation
[ peo] oss_0_port_8_pin_0
v External Tools
Pe[1] CYESP_CSD_BTNO, CYBSP_CS_BTND | Pin-2.0
N (2) Smart /0 Configurator |Launch Smart /0 Configurator ...
Pe[2] CVESP_CSD_BTNI, CYBSP_CS_BTNT | Pin-20 o
£ ¥ Genera
] -3.0 3
PE[3] CYBSP_CSD_SLDO, CYBSP_CS_SLDO | Pin ! . e O
Pa[4] CVBSP_CSD_SLDA, CYBSP_CS_SLDT |Pin-2.0 9E - v Advanced
Pa[s] CVBSP_CSD_SLD2, CYBSP_CS_SLD2 |Pin-2.0 206 ® o (?) Store Config in Flash
Pa[s] CVBSP_CSD_SLD3, CYBSP_CS_SLD3 |Pin-2.0
Pa[7] CVBSP_CSD_SLD4, CYBSP_CS_SLDA |Pin-2.0
o Smart I/0 8 icss_0_port_8_smartio_0 Smart /1
Port9
Port 10 st v
Port 11 —=
Port 12
Port 13
N 4
g > Smart1/0 8 - Parameters  Code Preview
Motice List X
00 Errors I 0Warnings DOTaslcs olilnfns
Fix Description Location
Ready
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2 Launch the Smart 1/0 Configurator

2.4 Executable (GUI)

If you don't have an application or if you just want to see what the configurator looks like, you can launch the
Smart I/O Configurator GUI by running its executable as appropriate for your operating system (for example,
double-click it or select it using the Windows Start menu). By default, it is installed here:
<install_dir>/ModusToolbox/tools_<version>/smartio-configurator-<version>

When launched this way, the Smart I/0 Configurator opens without any settings configured. You can either
open a specific configuration file or create a new one. See Menus for more information.

Note: The Smart I/0 uses the *.modus file that is also used by the Device Configurator for the same
application.

user guide 5 002-24729 Rev. *O
2025-08-29



o~ _.
ModusToolbox™ Smart I/O Configurator user guide |n f| neon

3 Quick start

3 Quick start

The Smart I/O is a port-wide resource that has a close relationship with the port to which it is dedicated. Hence
the connectivity of peripherals to the Smart I/0 will differ based on which device and which port is used. To use
the Smart 1/0:

1. Launch the Smart 1/0 Configurator.

2, Use the various pull-down menus to configure signals. Refer to the descriptions in the Routing tab
section for more details.
3. Save the file to generate source code.

The Smart I/0 Configurator generates code into a "GeneratedSource" directory in your Eclipse IDE
application, or in the same location you saved the *.modus file for non-IDE applications. That directory
contains the necessary source (.c) and header (.h) files for the generated firmware, which uses the
relevant driver APIs to configure the hardware.

4, Use the generated structures as input parameters for Smart 1/0 functions in your application.

For more information, refer to the Peripheral Driver Library (PDL) APl Reference documentation.
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4 GUI Description

4 GUI Description

The Smart I/0 Configurator GUI contains Menus and Tabs to configure I/O settings.
4.1 Menus

4.1.1 File

+ Open - Opens and loads an existing *.modus file.
+ Close - Closes the current file (leaves the application open).
+ Save - Saves changes to the file. If the file does not exist, the Save file dialog opens.

« Openin System Explorer - This opens your computer’s file explorer tool to the folder that contains the
design.modus file.

« Recent Files - Lists up to five recently opened *.modus files, which you can select to re-open.
+  Exit - Closes the configurator.

4.1.2 Settings

+  ModusToolbox™ Settings: This opens the Settings tool, an editor that allows you to configure a wide range
of settings for your environment, such as proxy settings, content modes, and manifest DB settings. See the
Settings tool user guide for more details on specific features.

4.1.3 View

+ Notice List - Shows/hides the Notice List pane, which contains any errors, warnings, tasks, and
information notes. See the Device Configurator user guide for more details.

«  Toolbar - Shows/hides the Toolbar.

4.1.4 Help

«  View Help - Opens this document.

«  About - Opens the About box for version information, with links to open Infineon.com and the current
session log file.
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4 GUI Description

4.2 Tabs

4.2.1 Routing tab

The Routing tab is used to define the general settings and the routing configuration of the Smart I/0.

Routing  DataUnit  LUT4
Port: [Smart /08 | Clock: |Asynchronous | | Show Routing Matrix | | X Clear

Chip7 | Bypass v

1707 | Bypass v

Chip 6 Bypass v
1706  Bypass v

Chip 5 |Bypass v
1/05 | Bypass -

Input(Async)

Serial Communication Block (SCB) 4 SPlselect]1] [USED] 1|

Chip 3 |Bypass v

1703 Bypass v

Chip2 |Bypass v
1702 | Bypass v

Chip 1 |Bypass v
1/01 |Bypass -

Chip0 |Bypass v
/00 | Bypass -

012 0 1 2 0 1 2
wro @ | wr @ wrz2 @

012 0 1 2
wre @ | wr7 @
None ~| | Mone ~| | Nome None | | None ~

None  ~ None  ~ None None  ~ None  ~

This tab contains the following parameters:

4.2.1.1 Port

Valid peripheral connections of a Smart 1/0O are port- and device-specific. This parameter allows selecting a port
that supports Smart I/0.

4.2.1.2 Clock

Selects the clock source used to drive all sequential logic in the block. This clock is global within the Smart I/O
and has differing constraints suited to different applications. Refer to the Functional Description section for
more information.

+ Signalon /0 terminal 7...0 - Uses the selected 1/0 signal as the clock source. This signal may not be used
in LUT inputs if used as the clock source.

+ Signal on Chip terminal 7...0 - Uses the selected Chip (peripheral or UDB) signal as the clock source. This
signal may not be used in LUT inputs if used as the clock source. This clock can only be used during chip
active and sleep modes.

+  Peripheral clock divider (Active) - Divided clock from HFCLK. This clock is operational only in chip Active
and Sleep modes. Sequential elements will be reset when entering Deep-Sleep or Hibernate mode and at
POR.

« Peripheral clock divider (Deep-Sleep) - Divided clock from HFCLK. This clock is operational only in chip
Deep Sleep modes. Sequential elements will be reset when entering Hibernate mode and at POR.

+  Peripheral clock divider (Hibernate) - Divided clock from HFCLK. This clock is operational only in chip
Hibernate modes. Sequential elements will be reset only at POR.
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4 GUI Description

+  Clk_LF - Low Frequency clock (either from ILO or WCO). This clock operates during chip Active, Sleep and
Deep-sleep and allows the Smart 1/0 sequential logic to be clocked during those power modes.

+  Asynchronous - If the Smart 1/0 is used purely for combinatorial logic, this option allows the block to
conserve power by not using a clock. There are no constraints to power modes with this selection.

4.2.1.3 Show Routing Matrix

This button hides or displays the Smart 1/0 routing matrix. If the routing matrix is shown, you may click on the
switches in the fabric to make input connections to the LUTs.

4.2.1.4 Clear

Click on this button to reset the routing matrix. All DU and LUT inputs will be cleared and the Chip and I/O
terminal directions will become bypassed.

4,2.1.5 Chip configuration

There are eight Chip signals that can be configured. Each has two pull-down menus; one to select the direction
of the signal and the other to select the connection.

Inputfsync) -

TCPWIM[0] 32-bit Counter 7 prrm_n [USED] - 1

Chip 7...0 direction

Defines the direction of the specified Chip terminal. Valid options include:

+ Bypass - The line is bypassed and do not go through the Smart 1/0 routing fabric. That is, the Connection
between the chip resource and the pin are directly connected. Bypass option frees this line and allows
ModusToolbox™ to use this pin location for placing resources not meant to be used in the Smart 1/0 fabric.

+ Input (Sync/Async) - Changes the direction of the terminal to be input type and allows connecting the
matching peripheral/UDB signal to it. Input signals can be used as inputs to the LUTs. These can be either
synchronized to the clock or remain asynchronous.

+  Output - Changes the direction of the terminal to be output type and allows connecting the matching
peripheral/UDB signal to it. Output signals can only be driven by the corresponding LUT outputs.

+ None - The Chip terminal is consumed and cannot be used for connecting chip resources to it. This option
is chosen automatically if the corresponding 1/0 terminal on the channel is specified as either Input or
Output. You may use the terminal if the direction is set to Output or Input (only allowed if corresponding
1/O is Output).

Chip 7...0 connection

When a Port is specified, these parameters allow each of the Chip terminals to connect to another peripheral
on the chip.

4.2.1.6 1/O configuration

There are eight 1/0 signals that can be configured. Each has a pull-down menu to select the direction of the
signal.
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4 GUI Description

1/0 7...0 direction

Defines the direction of the specified I/0 terminal. Valid options are:

+ Bypass - The line is bypassed and do not go through the Smart I/0 fabric. That is, the Connection
between the chip resource and the pin are directly connected. Bypass option frees this line and allows
ModusToolbox™ to use this pin location for placing resources not meant to be used in the Smart /O fabric.

« Input (Sync/Async) - Changes the direction of the terminal to be input type and allows connecting an
input 1/0 pin to it. Input signals can be used as inputs to the LUTs. These can be either synchronized to the
clock (Sync) or remain asynchronous (Async).

+  Output - Changes the direction of the terminal to be output type and allows connecting an output I/O pin
to it. Output signals can only be driven by the corresponding LUT outputs.

+ None-Thel/O terminal is consumed and cannot be used for connecting a pin to it. This option is chosen
automatically if the corresponding Chip terminal on the channel is specified as either Input or Output. You
may use the terminal if the I/O direction is set to Output or Input (only allowed if corresponding Chip is
Output).

4.2.1.7 Data Unit input configuration

The Data Unit configuration section contains three pull-down menus to select inputs. As you make various
selections, the Data Unit tab becomes available for selection. You can also click the link icon to access the tab.

DU TRO, TR1, TR2
Defines the inputs for Data Unit triggers TR0, TR1 and TR2. The purpose of the triggers are dependent on the
chosen Opcode as specified in the Data Unit tab. The triggers are active high.

+ Constant 0 - Default input selection. This effectively makes the trigger input to not perform any operation
on the DU.

+ Constant 1 - Ties the trigger high, which activates and maintains the chosen DU operation.
+ DU - Feeds back the single 1-bit DU output.
« LUTO...7 - Accepts any of the LUT outputs as an input.

4.2.1.8 LUT input configuration

There are eight LUT signals that can be configured. Each LUT configuration section contains three pull-down
menus to select inputs from Chip, 1/0, and DUT resources. As you make various selections, the corresponding
LUT tabs becomes available for selection. You can also click the link icon to access the tab.
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4 GUI Description

LUT 7...0, Input 0

Defines the input 0 of the specified LUT. The actual valid selection depends on the enabled/used resources and
terminals in your design. The LUT input 0 may accept any LUT outputs as an input with the exception of LUT 0.
Instead, it may accept the DU output as an input.

« DU -The 1-bit output from the DU.

« LUT1...7 - Accepts the outputs of LUT1 to LUT 7.
- Ifusing LUT 0...3,1/0 / Chip 0...3 signals are allowed as potential inputs.
- Ifusing LUT 4...7,1/0 / Chip 4...7 signals are allowed as potential inputs.

LUT 7...0, Input 1
Defines the input 1 of the specified LUT. The actual valid selection depends on the enabled/used resources and
terminals in your design.
« LUTO...7 - Accepts the outputs of LUTO to LUT 7.

- Ifusing LUT 0...3,1/0 / Chip 0...3 signals are allowed as potential inputs.

- Ifusing LUT 4...7,1/0 / Chip 4...7 signals are allowed as potential inputs.

LUT 7...0, Input 2
Defines the input 2 of the specified LUT. The actual valid selection depends on the enabled/used resources and
terminals in your design.
« LUTO...7 - Accepts the outputs of LUTO to LUT 7.

- Ifusing LUT 0...3,1/0 / Chip 0...3 signals are allowed as potential inputs.

- Ifusing LUT 4...7,1/0 / Chip 4...7 signals are allowed as potential inputs.
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4 GUI Description

4.2.2 Data Unit tab

When the DU in the Routing tab is configured to accept an input other than a Constant 0, the corresponding
Data Unit configuration tab will appear.

Routing  DataUnit  LUT4
Opcode: Increment ~
DATAD: Constant 0 v
DATAT: Constant 0 v
Size: 8-bits size/width operand ~
Details: Clock = Asynchronous
TRO = LUT4
TR1 = LUT4
Increment
du_size = Size - 1 ]
mask = (1 << (du_size + 1)) - 1 TRO — st Out—TR out
data_eql_data = (data & mask) == (DATAT & mask) -
Combinatorial:
tr_out = data_eq|_datal
- - TR1 — en
Registered/Clocked:
data <= data
if (TRO)
{ Clock — > clk
data <= DATAD & mask
i
else if (TR1)
{
data <= data_eql_datal ¥ data: (data +1) & mask
B

This tab contains the following parameters:

4.2.2.1 Opcode
Defines the Data Unit operation. Each opcode performs a unique function that can be controlled using the DU
trigger inputs TR0, TR1 and TR2.

Note: Not all trigger inputs are required for a chosen Opcode. Refer to the pseudo verilog code in the Details
window and also to the Functional Description section for more information.

+ Increment - Implements an 8-bit One-shot Up Counter. The DU output goes high when the internal DU
working data register is equal to DU DATA1 value.

- TRO=reset signal that resets the working register to DU DATAO value
- TR1=enablesignal to start the increment operation

+ Decrement - Implements an 8-bit One-shot Down Counter. The DU output goes high when the internal DU
working data register is equal to 0.

- TRO=reset signal that resets the working register to DU DATAO value
- TR1=enable signal to start the decrement operation

+ Increment and wrap - Implements an 8-bit Up Counter that wraps when it reaches DU DATA1 value. The
DU output is a single clock pulse when the internal DU working data register is equal to DU DATAL value.

- TRO=reset signal that resets the working register to DU DATAO value
- TR1=enablesignal to start the increment operation

+ Decrement and wrap - Implements an 8-bit Down Counter that wraps when it reaches 0. The DU output is
a single clock pulse when the internal DU working data register is equal to 0.

- TRO=reset signal that resets the working register to DU DATAO value
- TR1=enable signal to start the decrement operation

+ Increment/Decrement - Implements an 8-bit Up/Down Counter. The DU output goes high when the
internal DU working data register is equal to either DU DATAL register or if it is equal to 0.

- TRO=reset signal that resets the working register to DU DATAO value

user guide 12 002-24729 Rev. *O
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4 GUI Description

- TRl =enablesignal to start the increment operation
- TR2=enable signal to start the decrement operation

+ Increment/Decrement and wrap - Implements an 8-bit Up/Down Counter that wraps when it reaches
either DU DATA1 (count up) or when it reaches 0 (count down). The DU output goes high when the internal
DU working data register is equal to either DU DATAL register or if it is equal to 0.

- TRO=reset signal that resets the working register to DU DATAO value
- TRl =enablesignal to start the increment operation
- TR2=enable signal to start the decrement operation

+ Rotate Right - Implements a right circular shift register. The DU output is the LSB of the working register,
which also gets fed back to the MSB of the working register.

- TRO=load signal that loads the working register with DU DATAOQ value
- TR1=enable signal to start the shift right and rotate operation
«  Shift Right - Implements a right shift register. The DU output is the LSB of the working register.
- TRO=load signal that loads the working register with DU DATAOQ value
- TR1=-enable signal to start the shift right operation
- TR2=shiftin value that gets inserted into the MSB of the working register

+ AND, OR - Implements a bitwise AND operation on the DU working register and DU DATAL. The DU output
is high if the result of the operation is true.

- TRO=load signal that loads the working register with DU DATAOQ value

«  Shift right and Majority 3 - Implements a shift register with a majority 3 comparison. The DU output will
go high if the contents of the working register is equal to 0x03, 0x05, 0x06 or 0x007.

- TRO=load signal that loads the working register with DU DATAOQ value
- TR1=-enable signal to start the shift right operation
- TR2=shiftin value that gets inserted into the MSB of the working register

+ Shift right and Compare - Implements a shift register with a match DU DATA1 value comparison. The DU
output will go high if the contents of the working register is equal to DU DATAL.

- TRO=load signal that loads the working register with DU DATAOQ value
- TR1=enable signal to start the shift right operation
- TR2=shiftin value that gets inserted into the MSB of the working register

4.2.2.2 DATAO

Defines the DU DATAO register source. This value is often used as the initial/reset value that is loaded into the
DU working register when TRO signal is high.

. Constant 0 - Source is constant 0x00

«  Chip signal [7:0] - Sourced from all 8 Chip terminals of the Smart I/0, allowing internal chip signals to be
directly loaded into DATAO

« 1/0 Signal [7:0] - Sourced from all 8 1/0 terminals of the Smart I/0, allowing external signals to be directly
loaded into DATAO

«  DATA Register - Sourced from the DU Register, which is accessible by the CPU

4.2.2.3 DATAl

Defines the DU DATAL1 register source. This value is often used as the comparison value that gets applied to the
DU working register.

Note: DU DATAL is not necessary for all Opcodes.
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4 GUI Description

« Constant 0 - Source is constant 0x00

+  Chip signal [7:0] - Sourced from all 8 Chip terminals of the Smart I/0, allowing internal chip signals to be
directly loaded into DATAL

+ 1/O Signal [7:0] - Sourced from all 8 1/0O terminals of the Smart I/0, allowing external signals to be directly
loaded into DATA1

+  DATA Register - Sourced from the DU Register, which is accessible by the CPU

4.2.2.4 Register Value

Defines the 8-bit DU Reg value. This value is used as a source for DATAQ and/or DATAL.

Note: DU Reg is available only if either DATAO or DATA1 are configured to be sourced from it.
4.2.2.5 Size

Defines the bit size operation to be performed by the data unit. Valid range is from 1 to 8 bits.

4.2.3 LUT tabs

When a LUT in the Routing tab is configured to accept an input, the corresponding LUT configuration tab will
appeatr.

Routing Data Unit LuT4
Mode: Combinatorial cutput Mapping:

TR2Z (Chip 5 TR 1: (Chip 7) TRO: (I/04) Set Bit

0 0 0 0

12: o L?Okup @ ] 0 1 0

=F able

0 1 0 0

0 1 1 0

1 1 0 0

1 1 1 0
Output: Hex v 030

This tab contains the following parameters:

4.2.3.1 LUT 7...0 mode

The LUTs can be configured in one of four modes:

+ Combinatorial - The LUT is purely combinatorial. The LUT output is the result of the LUT mapping truth
table, and will only be delayed by the LUT combinatorial path.

+ TR2 gated, combinatorial output - The LUT input 2 is registered. The other inputs are direct connects to
the LUT. The LUT output is combinatorial. You may use the output to feed back into input 2.

+ Sequential (gated) output - The inputs are direct connects to the LUT but the output is registered.

« Asynchronous Set/Reset mode - The inputs and the LUT truth table are used to control an asynchronous
S/R flip-flop.
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4 GUI Description

4.2.3.2 LUT 7...0 output mapping

Defines the look-up truth table of the 3-to-1 LUT. The state on the three inputs (input 0, 1 and 2) are translated
to an output value according to this truth table.

Note: If the LUT is used to operate on a single signal (for example, to invert a signal), then that signal must
be connected to all 3 inputs of the LUT.

4.2.3.3 LUT 7...0 Notes

If visible, the Notes section allows you to document the interaction with the PSoC™ peripherals as you are
setting up the logic for each of the LUTs. For example, a common use case might be to condition a signal before
using it to trigger an internal peripheral. Having a comment about the logic setup provides a quick reference
when reviewing the design at a later time.
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5 Functional Description

5 Functional Description

The Smart /0 implements a port-wide logic array that can be used to perform routing and logic operations to
peripheral and 1/0 signals. The following sub sections describe the block restrictions and application critical
information.

5.1 Routing Fabric

The Smart 1/0 routing fabric is divided into two portions, where each portion is capable of accepting half of the
Chip or /0 signals. The LUTs have the following structure.

« LUT7...4 are capable of accepting signals from I/O / Chip 7...4 as inputs.

« LUT 3...0 are capable of accepting signals from 1/0O / Chip 3...0 as inputs.

«  TheLUTs can accept any LUT output as an input.

+  Each LUT output is dedicated to the corresponding output I/O and Chip terminals. For example, LUT 0 can
go to either I/0 0 terminal (output type) or Chip 0 terminal (output type). The LUT output cannot be routed
to an input terminal type.

5.1.1 Single Source LUT Input

If a LUT is used, all three inputs to the LUT must be designated. For example, even If a LUT is used to accept a
single source as its input, all three inputs must accept that same signal. The look-up truth table should then be
designed such that it only changes the output value when all three inputs satisfy the same condition.

For example, consider the case where the signal on Chip 5 must be inverted before being passed to I/0 5. LUT 5
accepts Chip 5 as input 0, 1 and 2. The truth table is defined such that it outputs a logic 1 only when the inputs
areall 0.

TR 2: {Chip 5) TR 1: (Chip 5) TR 0: (Chip 5) Set Bit

TRO - —
Lookup i a 1 i
WA ™ Table > Out -
TR2 - i 1 0 i
i} 1 1 o
1 a 0 o
1 a 1 o
1 1 1) o
1 1 1 o
Qukput: Hex - 0x01
5.1.2 SCB Restriction

The SCB routing paths are restricted and can only be connected to the dedicated pin. They can however go
through the dedicated LUT. For example, an SCB SPI slave select line on Chip 2 may be an input to LUT2, and
then the output go to 1/0 2. It cannot go to any other LUTs.

5.2 Clock and Reset behavior

The Smart I/0 Configurator drives its synchronous elements using a single peripheral-wide clock. Depending on
the clock source, the Configurator will have different reset behaviors, which will reset all the flip-flops in the
LUTs and synchronizers to logic 0. The configuration registers will retain their values unless coming out of
Power on Reset (POR).
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Note:

Note:

If the Configurator is only disabled, the values in the LUT flip-flips and /O synchronizers are held as
long as the chip remains in a valid power mode.

The selected clock for the fabric’s synchronous logic is not phase aligned with other synchronous logic

on the chip operating on the same clock. Therefore, communication between the Smart I/0 and other
synchronous logic should be treated as asynchronous (just as the communication between I/0 input
signals and other synchronous logic should be treated as asynchronous).

Clock source

Reset behavior

Enable delay

Description

1/07...0

Reset on POR

2 clock edges

If chosen as the clock source, that particular signal
cannot also be used as an input to a LUT as it may
cause a race condition. The fabric will be enabled
after 2 clock edges of the signal on the 1/0
terminal.

Chip7...0

Reset on POR

2 clock edges

If chosen as the clock source, that particular signal
cannot also be used as an input to a LUT as it may
cause a race condition. The fabric will be enabled
after 2 clock edges of the signal on the Chip
terminal.

Peripheral Clock
Divider (Active)

Reset when going to
Deep Sleep,
Hibernate or POR

2 clock edges

The fabric will be enabled after 2 clock edges of
the divided clock. Any synchronous logic in the
LUTs will be reset to 0 when in chip deep-sleep or
hibernate modes.

Peripheral Clock
Divider (Deep-
Sleep)

Reset when going to
Hibernate or POR

2 clock edges

The fabric will be enabled after 2 clock edges of
the divided clock. Any synchronous logic in the
LUTs will be reset to 0 when in hibernate mode.

Peripheral Clock
Divider (Hibernate)

Reset on POR

2 clock edges

The fabric will be enabled after 2 clock edges of
the divided clock.

Clk_LF

Reset when going to
Hibernate and POR

2 clock edges

The fabric will be enabled after 2 clock edges of
the low frequency clock (LFCLK). Any synchronous
logic in the LUTs will be reset to 0 when in
hibernate mode.

Asynchronous Reset on POR 3clock edges |The fabric will be enabled after 3 clock edges of
of SYSCLK the system clock (SYSCLK).
5.2.1 Signal synchronization requirement

If any of the signals coming in through the Smart 1/O are meant to be used in sequential elements in the LUTSs,
the terminal synchronizer must first be used to synchronize that signal to the peripheral clock. For example, if
the signal on 1/0 0 must be used in LUTO in Sequential output mode, the synchronization for 1/0 0 terminal

should be enabled for reliable operation.

user guide

17

002-24729 Rev. *O
2025-08-29



o~ _.
ModusToolbox™ Smart I/O Configurator user guide |n f| neon

5 Functional Description

5.3 LUT combinatorial feedback

Since the LUTs can be configured as purely (or partially) combinatorial elements and since they can chain to
each other in any fashion, combinatorial timing loops can occur. This causes oscillations that burn power and
create unpredictable behavior. If a feedback is required, the signals should always go through a flip-flop before
feeding back. For example, the following is a potentially problematic design. LUT1 and LUT2 are configured in
Combinatorial mode. This will result in oscillations. To prevent it, one of the LUTs should be configured to
Gated Output mode.

' |

In0 Inl In2 In0 Inl In2
LUT1 LUT2
out out
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6 Version changes

This section lists and describes the changes for each version of this tool.

Version Change descriptions

1.0 New tool.

1.1 Updated to incorporate changes to the back end.

1.2 Implemented various defect fixes and performance enhancements.

Added Open Containing Folder menu item.

2.1 Updated to incorporate changes to the back end; version updated to be in sync with Device
Configurator.

Added Open System Explorer menu item.
Added Change Devices menu item and dialog.
Added major/minor version number to the title bar.

2.20 Added Copy feature to the Notice List.
Added feature to support incremental patch updates.

221 Updated versioning to support the updated backend.

3.0 Removed Change Devices dialog.

3.10 Locked down number entry to the English format (decimal place is always a period).
Added a log file that can be accessed from the About box. Debug messages are redirected to
it.

4.0 Updates to underlying structure; no visible changes in the tool.

Changed the device library file from xml to props.json.

4.10 Added Settings menu and items.

4.20 Removed the Save As and Change Libraries menu items.
Removed New Design dialog and menu items.

Added a Notes field to the LUT tabs.

Back-end changes.

4.21 Minor back-end changes.
4.30 Minor back-end changes.
4.40 Minor back-end changes.
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Revision |Date Description

** 2018-11-27 |New document.

*A 2019-02-26 |Updated to version 1.1.

*B 2019-10-16 |Updated to version 1.2.

*C 2019-11-19 |Added GitHub link to the document.
*D 2020-03-27 |Updated to version 2.1.

*E 2020-09-01 | Updated to version 2.20.

*F 2020-12-20 |Updated to version 2.21.

*G 2021-03-15 |Updated to version 3.0.

*H 2021-09-08 | Updated to version 3.10.

*| 2022-09-12 | Updated to version 4.0.

*J 2023-05-08 | Updated to version 4.10.

*K 2024-02-23 | Updated to version 4.20.

*L 2024-09-27 |Updated to version 4.21.

*M 2024-12-06 |Updated to version 4.30.

*N 2025-03-21 | Updated to version 4.40.

*0 2025-08-29 | Updated to version 4.50.
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